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at the time of this writing, the winner of the

Man Booker Prize for Fiction 2006 had just been an-
nounced. The Inheritance of Loss, written by Kiran 
Desai, follows the footsteps of a “shadow class” of 
people who, as they travel distances to pursue hope, 
don’t fi t into the stereotype or “shiny version” of 
what is referred to as globalization.

Here in the real world, some people don’t feel as 
if they fi t in because they are shy, introverted, or 
reserved in some way. And even though they may 
rather be home reading a book, some introverts do 
want to learn the art of networking, as networking 
is still the number one way to get a job, a promotion, 
or a partner. 

This month’s issue includes networking tips for 
the introvert in the article A Room full of Strangers. 
We also have an account of that great networking 
event, The Word on the Street, held in Toronto and 
in Kitchener on September 25.

Thanks for reading.
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Program report

The pain and pleasure 
of editing

Five accomplished EAC editors were in the spotlight at the 
Toronto branch’s  September meeting. They offered their insights, 
wisdom, and tips on editing—laced with generous amounts of 
humour—to an appreciative audience.             by Trudi Down

T

he panel, comprised of lee d’anjou, 

Kathryn Dean, David Peebles,  Ruth Pincoe, 

and Rosemary Shipton, had been asked to 

address the question of how does one become a 

good and successful editor. As past recipients of 

the Tom Fairley Award for Editorial Excellence, 

these fi ve certainly know a thing or two about 

the problems and pitfalls that can overtake a 

project and/or overwhelm an editor—and how 

to overcome these problems to ensure success.

The evening began in grand style with the skit  

“A Project from Hell.” The scene: three co-authors 

from different parts of the country are hired 

by an educational publisher to write a science 

college textbook. In a very funny back-and-forth 

exchange of short progress reports, Ruth and 

David covered many of the typical production 

problems: one author leaves the country, prima donna egos are bruised, mislaid 

proofs are found in the nick of time in the blue box on garbage day. By day 60, 

with the project still a long way from completion, everyone—including the edi-

tor—is ready to give up. 

Giving up is not what we as editors do, however. Lee d’Anjou spoke next about 

the need to be aware of the author’s feelings of vulnerability when working on 

his or her manuscript. She illustrated the point that authors often have a very 

Ruth Pincoe and 

David Peebles 

entertain with 

the skit “A 

Project from 

Hell.”



  november 2006            5

The pain and pleasure of editing

thin skin. In the words of Dennis Lee, “[an author is 

typically] in a state of extreme vulnerability of walk-

ing around with no skin—nerve endings exposed …” 

(Author & Editor: a Working Guide, the Writers Union 

of Canada, currently out of print).

She reminded us to “be frank and clear, and treat 

the author with decency.” Lee also provided a hand-

out of “Lee’s Ground Rules for a Happy Author/Editor 

Relationship.”   

Kathryn spoke about how editing has changed with 

the introduction of computers. “Electronic editing 

has changed the author/editor relationship,” she 

noted. While it is possible to do an entire editing proj-

ect without ever meeting the author, she prefers to 

make a face-to-face connection. Kathryn doesn’t like 

to use the Track Changes function of Microsoft Word, 

preferring to make comments inside square brackets 

directly in the text. Editors play various roles, she 

noted: as coaches, they help the author do the best 

writing possible; as surgeons, they excise the bad and 

rearrange the good; as legal eagle eyes, they look for 

potential libelous material.

“Editing is a bit of a balancing act,” she said. “You 

need to be fi rm, but you want to have a good relation-

ship with the author at the end of the project.”

Rosemary then provided her “Four Steps to 

Becoming a Great Editor.” Training is paramount, she 

began. Learn the skills and conventions, take courses, 

practise on real-world material, buy and study style 

books, and become a careful reader of good authors. 

Obtaining real-world experience is an important 

next step, and people just starting out in an editing 

career can do this by volunteering their services, and 

through sub-contract and in-house work. Thirdly, she 

advised her listeners to build an expertise by concen-

trating on one aspect of editing, such as copy editing, 

and one type of editing project such as textbooks or 

corporate work. After building a reputation in your 

specifi c areas of expertise, you can then move into 

other kinds of editing projects. Finally, when you have 

mastered the skills, do something unusual! 

“Break the rules and conventions; become more 

creative. This will stretch you in new ways, and you 

will never edit the same way again.”

Ruth followed, with her ten guidelines on how to 

have a successful editing career.

❝  Always do your best
❝  Quote carefully and fairly
❝  Don’t charge for time taken to learn or develop 

new skills
❝  Keep up with your professional development
❝  Contract out when you experience a time 

crunch

❝  Build on your subject knowledge
❝  Do not take advantage of colleagues
❝  Consider specialization
❝  Develop more than “one string to your bow”

     ❝  When faced with a diffi cult project, think care-

fully and follow your heart.

David provided an intriguing end to the evening by 

drawing an analogy between theatre and editing. An 

avid volunteer in community theatre, he creatively 

developed this theme and drew a number of clever 

comparisons. In both fi elds, he summarized, you 

will fi nd tough schedules, absurd deadlines, diffi cult 

people with whom you have to work, and an expecta-

tion of receiving the very best product for no money. 

For both theatre and editing, he added, “When the 

project comes off—it’s magical!”   �

Coming in November … 

Small Offi ce Strategies

Elizabeth Verwey, a seasoned entrepreneur 

who helps small business owners effectively 

manage their space and time, will present 

some practical strategies for setting up and 

maintaining small offi ces. She will provide 

time management tips to help achieve bal-

ance between work and home, and details on 

how to create a supportive network to help 

set monthly business goals. This informa-

tion-packed presentation will also feature two 

exercises.
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A

 Executive news

as public relations chair, i have been focusing on

outreach work. As well as attending Harbourfront 
Readings and displaying our seminar brochures on the 
book tables, I also staffed a table at Ryerson School of 
Journalism’s annual wordstock festival on October 14 
and spoke with many interested young journalists. One 
person joined on that day, and several people walked away 
with our literature. 

In addition, an editor of the globe and mail asked me 
to speak to her colleagues about joining the EAC.  I will 
likely meet with them in the coming weeks. 

I also met with an editor at hansard reporting and 

interpretation services (Ontario Legislature) about 
signing him and his colleagues to the association. He is 
particularly interested in having Hansard editors partici-
pate in EAC seminars.  

It has been a great start to the year for EAC public 
relations.

Noreen Shanahan is Public Relations Chair of the EAC 

Toronto branch.  toronto_br_pr_chair@editors.ca

Public relations outreach
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For your diary pages

Executive meeting    General meeting
Monday, November 13, 2006    Monday, November 27, 2006
6:30 p.m.       6:45 p.m. New members Q&A
EAC offi ce, 27 Carlton Street, Suite 502   7:30 p.m. Business meeting
All members welcome     8:30 p.m. Program: Organize your 
RSVP: Ann Firth, 905 464-6373    Home Offi ce      
toronto_br_secretary@editors.ca                                23 Prince Arthur Avenue
        Members free / non-members $5

Welcome! New members
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Meeting schedule and new members information

As of October 6, 2006, the Toronto branch had 703 members (315 vot-
ing, 388 associate). Twenty-four people joined in October, nine allowed 
their membership to lapse, and three members identifi ed themselves as 
francophone.
Here is a list of the new members registered in October:

Edward Bird

Megan Burns

Lynn Burton

Andrea Chomyn

Smita Devene-Bhan 

Marie Dowler

Sylvie Duong

Michele Foulds

Karen Gilmour

Tabitha Keast

Marcy Kennedy

Janice Kretchman

Gina Li

Elizabeth MacLean

Talia Maze

Sean McGrady

Karen Meagher

Leslie Mutic

Therese Parent

Joanna Shaw

Laryssa Stolarskyj

Peggy Sweeney

Suzanne Taylor

Randy Threndyle

Michele Viner

Kathryn White
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Hotline Report      October 2006

Members registered        7

Clients registered        1

Project   Manuscript for proofreading

 
 

 

Located via prior experience with the Hotline service

Hotline Registration   
Clients call to be matched with branch members who 
have registered with the Hotline for work.
When you register, please note these guidelines:

   If you are listed in the EAC Directory of Editors 
(print or online), note any changes to your listing.

   If you are not listed in the Directory and have not 
previously registered with the Hotline, send your 
résumé in Directory or Hotline style. You can fi nd 
guidelines to the Directory format at www.editors.
ca/ode/index.htm. Hotline style follows the Directory 
format. However, you may include as many interests 
as you wish and write your profi le in point form.

   Please limit your résumé to one page.

   If you have registered before, send your resume 
only if it has changed.

   Hotline registration begins on the fi rst of each 
month. Please contact the branch every month to be 
listed again.

Telephone: 416 860–8511  Fax: 416 975–5596

Hotline report and registration

www.editors.ca/ode/index.htm
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Professional development 

November seminar season

November is the fi nal month of the Fall 2006 Professional Development 

season. See page 24 in the Networking directory for more information. Don’t 

miss:

Substantive Editing Advanced tackles deeper issues than past seminars 

on substantive editing. Experienced editors won’t want to miss it! Rosemary 

Shipton teaches on Saturday, November 4, at Northrop Frye Hall. 

Conquering Corporate Markets with Paul Lima is offered on Saturday, 

November 11, at Northrop Frye Hall. This seminar is a must for editors and 

writers interested in attracting corporate clients.

On-Screen Editing with Anne Stilman gives you all the tips and tricks you 

need to become an expert at editing using Microsoft Word. This seminar 

takes place on Saturday, November 18, at Northrop Frye Hall.

Proofreading with Gillian Watts takes place on Saturday, November 25, at 

Northrop Frye Hall.

Graphic Design Basics for Editors with Ingrid Paulson returns on 

Sunday, November 26, at Northrop Frye Hall.

Eight-Step Editing is here with Elizabeth d’Anjou following in the foot-

steps of creator Jim Taylor. This seminar is offered on Tuesday, November 28, 

at the Lillian H. Smith Library.

Please see www.editors.ca/branches/toronto/seminars/index.html for com-

plete information and registration, or call 416 975-5528, Monday through 

Thursday, 9 am to noon.

www.editors.ca/branches/toronto/seminars/index.html
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Match each word in the list with its meaning below: 
ardour, mellifl uous, insouciant, tawdry, pellucid, desiccate, harrow, 

volubility, dulcet, dross

1. cheap, gaudy, showy, tacky

2. waste product, sludge; something worthless, common, or trivial

3. warm interest, passion, enthusiasm, zeal

4. unconcerned, carefree

5. fl uency, verbosity, easy use of spoken language

6. melodious, harmonious

7. sweetly fl owing; usually used to describe use of words 

8. to dry up, dehydrate

9. to distress, create stress or torment

10. transparent, easy to understand

Answers:

1. cheap, gaudy, showy, tacky — tawdry

2. waste product, sludge; something worthless, common, or trivial — dross

3. warm interest, passion, enthusiasm, zeal — ardour

4. unconcerned, carefree — insouciant

5. fl uency, verbosity, easy use of spoken language — volubility

6. melodious, harmonious — dulcet

7. sweetly fl owing; usually used to describe use of words — mellifl uous

8. to dry up, dehydrate — desiccate

9. to distress, create stress or torment — harrow

10. transparent, easy to understand — pellucid

Sign up for your free newsletter and test your word skills with a weekly quiz: 

WritingTips-subscribe@yahoogroups.com

VOCABULARY QUIZ
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T o r o n t o
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The Word on the Street 

T
oronto branch eac volunteers 

converged on the EAC Toronto WOTS booth 

on September 24 at Queen’s Park Crescent 

in Toronto. Despite the brisk morning wind, the 

EAC booth was set up and attracting visitors by 

10 a.m. under clear skies. The day’s visitors in-

cluded veteran and novice EAC members, brows-

ers who collected materials from every WOTS 

exhibit, and people interested in aspects of edit-

ing, ranging from education, membership in the 

association, and editorial expertise. 

    Again this year, visitors grabbed seminar bro-

chures, pamphlets on editing, information sheets 

on membership benefi ts and certifi cation, and 

EAC application forms. About 60 people tried 

their skill at the Easy-Hard Word Choice contest 

(the winner, selected at random from correct 

entries, was a York University student who se-

lected the Introduction to the Publishing Process 

seminar as the prize). 

    The EAC Toronto branch thanks volunteers 

Mike Brassard, Alexandra Romic, Adrienne Snow, 

Nancy Ackerman, Maureen O’Connor, Annie 

Leung, Eva Zeppa, Jane McCaig, Ian Darragh, 

and Sarah Head for coming out for cookies, TTC 

tokens, and fresh air. 

The Word on the Street

by Karen Black
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by Ann Firth

Mother nature may have favoured toronto on 

September 25, but downtown Kitchener put on 

a brave face as host to the Fifth Annual Word on 

the Street (WOTS) Book and Magazine Fair in the beauti-

ful Victoria Park in downtown Kitchener. The weather was 

mostly cool and wet that day, with a couple of brief sunny 

periods. The line of attendees may have been sparse at 

times but it was steady, with people in rain gear and some 

holding umbrellas.

Kitchener is the newest addition to the WOTS day; 

Toronto is the oldest at 17 years (and the biggest with over 

300 scheduled exhibitors). True to the theme of celebrating 

reading and advocating literacy, an assortment of business-

es and associations were lined up for Kitchener. Thanks to 

the efforts of John Green, the Toronto branch Professional 

Development Co-chair, the EAC too was well represented. 

This was a great opportunity to spread the word about the 

EAC, as well as what editors do, and I think we did a pretty 

good job!
John was at the booth for the afternoon along with volunteers 

Mary-Ann Wiersma, Ann Firth, Krysia Lear, Michael Peebles, and 

Nathan Medcalf. We had various reference books on display and 

John, Krysia, and Michael provided editing samples to show what 

editors “do.” All of these, along with general curiosity 

K
i
t
c
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about our association, helped draw people in. Almost 70 

people walked away with EAC information, including 45 

Toronto branch seminar brochures; we quickly ran out of 

these brochures hopefully boding well for attendance.

We talked to current editors and writers, people look-

ing for an editor, and people thinking about making 

editing their career. I had a chance to talk to a couple of 

writers/editors who had recently moved to Canada, and 

extolled the virtues of membership and community that 

the EAC provides. My most interesting conversation was 

with a comic book/graphic novel artist and writer. He 

and his wife, who helps proofread his material, agreed on 

the importance of editing—especially having seen many 

books in his profession that were in desperate need of an 

editor’s touch.

Along with the many exhibitors scheduled for WOTS, 

the organizers also planned events to take place during 

the afternoon. Beyond the Page hosted sessions on how 

to get published and on blogging, a cartooning demons-

stration, and a discussion on fantasy fi ction with author 

Guy Gavriel Kay. Then the Record Tent was the place to 

go for a handwriting analysis, and to meet The Record 

(Kitchener’s newspaper) reporters and the newspaper’s 

mascot Booker Bear.

Canadian Reading Rocks, presented by the 

Department of Canadian Heritage, hosted readings by 

authors Aubrey Davis, Sean Cassidy, Bob Barton, Marsha 

Skrypuch, and Edo von Belkom. The 96.7 CHYM FM/570 

News Authors Tent was the site of more readings by Kim 

Moritsugu, Louise Penny, Guy Gavriel Kay, Emma Cole, 

Elizabeth Ruth, Helen Humphreys, Jon Evans, Kelley 

Armstrong, and Sharron Smith.

Over on the CTV stage, Flamenco Rain, Latin Fusion 

Trio, and Jet Jaguar Trio provided musical entertainment. 

Later in the afternoon, at the Celebrity Spelling Bee, local 

personalities squared off in two teams for what promised 

to be a lively and entertaining match of skills. Included 

in the lineup were a number of Kitchener local personali-

ties along with the 2005 Regional Spelling Bee of Canada 

champions.

All in all, a good afternoon for EAC and literacy! I look 

forward to seeing Kitchener’s WOTS grow and, along 

with the other cities, host the event for many years to 

come. You can fi nd out more about WOTS by visiting the 

national Web site at www.thewordonthestreet.ca, and ac-

cessing the various city pages.  �

The Word on the Street

Karen Black and Ann Firth are executive 

members of the EAC Toronto branch.

www.thewordonthestreet.ca
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rammar food for thought
 An editor’s observations on grammar and usage 

by Freya Godard

Language

Trouble with 
gerunds

Although a gerund looks exactly like a present participle—that is, it 

ends in ing—its verb functions are combined with those of a noun 

and so, theoretically, it can do anything a noun can do. In practice, 

however, it should not be allowed to.

The most common and unexceptionable use of the gerund is as the 

object of a preposition, as in By bicycling to work every day, she was 

able to save $25 a week. But if that sentence is changed to read By bi-

cycling to work every day, it is possible to save $25 a week, the gerund 

becomes a dangler with no subject. Although that kind of sentence 

may be acceptable in casual speech or informal writing, the following 

is not: By adding some space-saving tricks, multifunctional furniture 

and jazzy accents, this loft is now a perfect marriage of function, so-

phistication, and style. Here the gerund has a subject, but obviously 

not the right one; in fact, there’s no word in the sentence that could 

logically serve as subject of the gerund.

A second use of the gerund is as a subject complement (or subjec-

tive completion or predicate nominative, as it is also called). A typical 

example is The soldiers’ fi rst task on arriving at the fl ooded river was 

building a bridge. Although the gerund is theoretically plausible here, 

the unfortunate juxtaposition of was and  building gives the impres-

sion, even if only momentary, that the reader is looking 

Perhaps because of their hybrid character, verbals 
are the source of countless grammatical errors, the 
most well-known of which is the dreaded dangling 
participle. But gerunds (and infi nitives) can also 
dangle and can cause trouble in other ways as well.
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Grammar food for thought

at the past progressive of build and 

that a task was building a bridge. 

In that sentence, the gerund should 

be replaced by an infi nitive:“The 

soldiers’ fi rst task was to build a 

bridge.”

A third use of the gerund is as a 

direct object of a verb, as in Takhar 

defended including the anti-scoop-

ing provision in his safety bill, say-

ing it saves passengers from being 

bilked through overcharging. Here, 

although the meaning is clear, the 

juxtaposition of a verb and a verbal 

can be abrupt and jarring, and in 

this example it sets up an unwant-

ed verse-like rhythm. This sentence 

reads much more smoothly if the 

gerund is replaced by a noun: 

Takhar defended the inclusion. . . . 

The use of the gerund that I 

fi nd most troubling is as a subject. 

Except in very short sentences, 

where the syntax can be seen at 

a glance—such as Seeing is be-

lieving—there is a fundamental 

diffi culty with this construction. 

Traditionally, an ing word at the 

beginning of a sentence has been 

a present participle modifying 

the subject: Characterizing Ms. 

Campbell as kowtowing to politi-

cal elements such as the military 

helicopter lobby, Mr. Chrétien said 

in Edmonton that the Conservative 

leader lacks personal convictions. 

Today, however, with the pro-

liferation of gerundial subjects,  a 

reader often has no way of knowing 

if an ing word at the beginning of a 

sentence is a participle or a gerund 

and may well have to stop and go 

back to the beginning. That’s what 

happened to me when I fi rst read 

this sentence: Considering the 

causes of terror is neither softhead-

ed idealism nor the appeasement 

of evil, says confl ict analyst Homer-

Dixon. 

Another diffi culty with using ger-

unds as subject is that it makes for 

too many sentences or clauses that 

begin with the subject, creating an 

effect which Edward Johnson com-

pares to “hammer blows.”� When 

the subject is a noun, the hammer 

blows are sometimes softened by 

defi nite articles or possessive pro-

nouns, but that can’t be done when 

the subject is a gerund. 

A fi nal problem is that when 

the gerund is the subject it often 

expresses the most important idea 

in the sentence or clause and there-

fore belongs at the end in the most 

emphatic position. On the other 

hand, as in some of the sentences 

above,  a gerund doesn’t work well 

as a subjective complement or as 

an object of a verb. This problem 

can be seen in this paragraph:

Perennials are a great investment 

in any garden, but once established, 

they can double and sometimes 

triple in size every year, creating 

a cluttered garden composition. 

Separating a parent plant into 

several pieces with their own roots 

and new crown to produce exact 

copies of that perennial is one way 

to deal with the clutter. The offend-

ing gerund should be replaced with 

an infi nitive and changed from 

subject to subject complement: 

One way to deal with the clutter is 

to separate a parent plant . . . .

Similar problems can be seen in 

the following example, even though 

the gerund doesn’t appear at the 

beginning of the sentence: 

If the international community 

wants Hezbollah and Hamas to 

wither as the IRA is slowly wither-

ing in Northern Ireland, guarantee-

ing fair borders for a generation 

would be a good start. 

Again, it’s not immediately obvi-

ous that the gerund is the subject, 

and again the best solution is to 

change the gerund to an infi nitive 

and move it to the emphatic end 

position, where it becomes the 

subject complement:

. . . a good start would be to guar-

antee fair borders . . . .

Although some linguistic inno-

vations fi ll a need, a construction 

that can cause so many barriers to 

communication is not a useful ad-

dition to the language.  �

 
� Edward D. Johnson, Handbook 

of Good English (New York: 

Washington Square Press, 1983), 

217.

Freya Godard has been a freelance edi-

tor and writer for more than 25 years. 

She also does indexing and translating 

and has taught many EAC seminars. In 

a previous career she taught high school 

French and German, adult ESL, and 

university-level writing. Freya lives on 

Toronto Island. godard@colcomm.ca 

416 214-0183, ext. 13
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TekTips

 Would you like to customize your 

reading  experience? Whichbook lets you fi nd 

just the right book to fi t your mood, narrowing 

down your search to what you are looking for in 

a main character or setting. 

www.whichbook.net/index.jsp

Reverse the order of a list of names 

in microsoft word—special-characters-and-

table method.
�  Highlight the list of names. Press Control H to 

fi nd and replace. Find what: ^p with no space be-

fore or after this mark. Replace with: ,^p. Choose 

Replace All. Each name on the list will have a 

comma.  �  With the list still highlighted, go to 

Table>Convert>Text to Table. Under Separate 

Text at, choose Other. Delete whatever charac-

ter may be in the box, hitting the spacebar once. 

Then set the number of columns to 3 at the top 

of the window. Choose OK.  �  Highlight the 

entire fi rst column by positioning your cursor 

over the top until you get a down arrow. Choose 

Cut from the Edit menu. Move the cursor to the 

last column and paste the contents. Highlight 

the last blank column and delete it by selecting 

Table > Delete > Columns.  �  To alphabetize the 

list, highlight the table (Table > Select > Table), 

then choose Table > Sort. Choose Column 1, then 

click the Ascending radio button. Choose OK. 

To hide the gridlines, highlight the table then 

choose Table > Table Properties > Borders and 

Shading > Borders > Setting > None. You can 

then hide the gridlines by choosing Table > Hide 

Gridlines.  �  Now adjust the width of all the 

columns so that the names are displayed closer 

together. Highlight the table, then choose Table > 

AutoFit > AutoFit to Contents. 

 

How to make a keyboard macro in 

Microsoft Word. From the toolbar, select 

Tools > Macro > Record new macro. Click on the 

Keyboard icon. Under Press new shortcut key, 

type a combination keystroke using Alt or Ctrl 

plus a character. If that keystroke is already as-

signed, it will indicate that under “Currently as-

signed to.” If not, it will say “[unassigned].” Click 

on the Assign button, then Close. The macro 

toolbox will then appear. Now create the steps 

for the macro. For example, if you want specifi c 

characters to be 14 pt instead of 12 pt, you would 

select from the main toolbar Format > Font 

> Size. Select 14 from the Size menu, click OK. 

Then press the Stop button on the macro tool-

box. You are done. Next time you type, highlight 

the characters you want to be 14 pt and type the 

keystrokes for the macro.

Do you want to visit web sites anony-

mously? Surf the Web through Anonymizer. 

Anonymizer prevents sites from tracking your 

explorations with an on-off switch on the toolbar. 

A free version is available as well as a licensed 

version for US$29.95 per year. 

www.anonymizer.com.

And how about a two-hour e-mail ad-

dress? Whenever a Web site wants you to regis-

ter, use Spamhole. Spamhole forwards all mail to 

your real address, but after two hours (up to 72 

hours), any additional mail won’t fi nd its way to 

you. www.spamhole.com. 

Distinguished Women features biogra-

phies of women who have made great societal 

contributions both in the past and at present. 

You can search by name or by subject area. 

www.distinguishedwomen.com 

Tips, tricks, and cool Web sites

www.whichbook.net/index.jsp
www.anonymizer.com
www.spamhole.com
www.distinguishedwomen.com
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In the news

Margaret Atwood is the new Jane Austen. A-level students in 
Britain once had to study Chaucer or Shakespeare as part 
of the syllabus. But nowadays the books of contemporary 
authors such as Margaret Atwood and Zadie Smith have 
become set text. Who decides which books become set text, 
and why are the publishing houses so interested? Read John 
Mullan’s commentary at http://books.guardian.co.uk/com-
ment/story/0,,1929192,00.html.

The Toronto Society for Technical Communication is holding 
its annual documentation competition. You are invited to 
participate by entering content for judging by technical com-
municators in the GTA. Information can be found online at: 
www.stctoronto.org. Follow the Competition link in the left 
frame for details. Mention that you are an EAC member to be 
eligible to enter at the STC-member rate of $95.

Make cold calling work for you. Check out Adrian Blake’s 
“Finessing the Fear” workshop on cold calling techniques for 
freelance writers and editors. Saturday, November 18; register 
by November 11. www.adrianblake.com/workshops.html.

www.adrianblake.com/workshops.html
www.stctoronto.org
http://books.guardian.co.uk/comment/story/0,,1929192,00.html
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A room full of 
strangers—
networking tips for 
introverts   by Karlene Ruddock

t some point in your life you may attend a cocktail party, or a con-

ference or an EAC Monday night meeting on your own. If you are 

the outgoing type, when you arrive you may introduce yourself to 

others and be networking in no time. But if you are the shy type, 

you may head for the coffee table, pour yourself some coffee and 

stand in a corner wishing you were home reading a book instead.

But shy people can be successful at events, says Diane Darling, author of 

Networking Survival Guide. Darling, herself an introvert, says that we can all 

network; we just need to fi nd our own style. She gives some tips on networking 

at a common event—the conference.

A
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A room full of strangers

When attending a conference, prepare yourself by 

doing the following:

 � Research the event to get a sense of who will be there. 

Use that information to break the ice.

 � Write down an introduction of yourself and rehearse 

it. The more you use this introduction, the less anx-

ious you will feel.

 � Stand out from the crowd by wearing some colour, 

apart from blue (to distinguish yourself from the 

many blue suits).

 � Be one of the fi rst to arrive at the event. This way, oth-

ers come into your space, you don’t have to go into 

theirs.

 � Eating and talking go together. So head 

for the breakfast table or the coffee table, 

not because you are hungry, but because 

people tend to be accessible around food, 

and it’s a great way to start a conversation.

 � Circle the room once to scan name tags to 

get an idea of who is in the room. Then pick your tar-

gets. While talking to people, maintain eye contact 

and avoid reading name tags.

 � Make small talk. Small talk includes as many people 

as possible and excludes few. But avoid topics such as 

politics and religion. Focus on topics that others can 

join in and that are of local or personal interest.
�  If the room is crowded, look for people who are stand-

ing alone. Approach them with a smile. One-on-one 

makes for effective networking.

 � Carry yourself as if you are having a good time. Don’t 

fold your arms.
� Have a good business card with some text on the 

back. Darling usually carries a small leather portfolio 

with two pockets—one for business cards coming in, 

and the other for cards going out. You can also wear a 

jacket with two pockets for the same purpose.
�     And at the end of the event, follow up with handwrit-

ten thank-you notes. Consider bringing cards and 

stamps with you and writing and mailing these notes 

right after the conference.

And what if you, the introvert, are a guest speaker 

or are giving a presentation at a conference?

 �   First, know your material. Practise out loud in front 

of the mirror or with a few friends.

 �   Consider joining Toastmasters’ or taking acting 

lessons to get over shyness. The more you practise 

public speaking and get positive feedback, the more 

confi dent you feel. 
 � When you are the speaker, people come up to you 

and ask questions. When you take on a role, much of 

the work of having to approach other people is taken 

away from you, making networking easier.

Other forms of networking are available, apart from 

attending conferences. For example, taking classes or 

workshops to hone work-related skills lets you meet 

others in your industry and gives you a chance to 

converse with them. Volunteering at events is another 

form of networking that allows you to take on a role 

where people approach you and ask questions. This 

reduces the pressure of you having to approach other 

people. Also, talk to strangers in safe places like in 

airports or at the post offi ce. It’s a great way to start a 

conversation and practise your skills with no risk.

People often fi nd clients and work through situ-

ations that have nothing to do with their jobs. But 

remember that not every encounter need be a way to 

network or to gain contacts, as that can be draining! 

The next time you attend an event, think of 

how you can solve someone else’s problem 

rather than think, “A room full of strang-

ers!” Finally, stay in touch with people 

you like by owing them something—an 

article, the name of a good book, the 

name of a key contact. There’s no pressure to be 

something you’re not. You don’t have to be bold—just 

be yourself. Visit http://xplane.com/explains/effective-

networking/loader.html for a multimedia demo of the 

above tips.   �

Karlene Ruddock is the editor and designer 

of Edition. minutesbykay@editors.ca

http://xplane.com/explains/effectivenetworking/loader.html
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All events are in Toronto unless otherwise noted.

ART BAR POETRY SERIES
www.artbar.org 
Poetry Readings
When:  Tuesday, November 7, 14, 21, and 28, 8 p.m. 
Where:  The Victory Café, 581 Markham Street (one 
block west of Bathurst Street,
one block south of Bloor Street)
Cost:  Free; however, they pass a hat for voluntary 
donations  

ATKINSON COLLEGE, YORK UNIVERSITY
www.yorku.ca/akevents
Canadian Writers in Person Series
Author Reading:  John Unrau will read from his book, 
Iced Water
When:  Thursday, November 2, 7 p.m.  
Where:  Accolade West Building, Room 206, York Uni-
versity, 4700 Keele Street (at Steeles Avenue)
Cost:  Free
Contact:  Diane Stadnicki at 416 733-2100, ext. 55870 
or dianes@yorku.ca 

Author Reading:  Shauna Singh Baldwin will read 
from her novel, The Tiger Claw
When:  Thursday, November 16, 7 p.m.
Where:  Accolade West Building, Room 206, York Uni-
versity, 4700 Keele Street (at Steeles Avenue)
Cost:  Free
Contact:  Diane Stadnicki at 416 733-2100, ext. 55870 
or dianes@yorku.ca 

Author Reading:  Joseph Boyden will read from his 
novel, Three Day Road
When:  Thursday, November 30, 7 p.m.
Where:  Accolade West Building, Room 206, York Uni-
versity, 4700 Keele Street (at Steeles Avenue)
Cost:  Free
Contact:  Diane Stadnicki at 416 733-2100, ext. 55870 
or dianes@yorku.ca   

BOOKFESTWINDSOR
www.bookfestwindsor.ca 
When:  Friday, November 3 to Sunday, November 5
Where:  The Art Gallery of Windsor, 401 Riverside 
Drive West, Windsor; and Windsor Public Library, Cen-
tral Branch, 850 Ouellette Avenue, Windsor, ON
Contact:  Lenore Langs, chair of BookFestWindsor, at 
langs@cranberrytreepress.com 

THE BOOK LOUNGE
www.rabble.ca/lounge 
Author Reading:  Wayne Johnston reads from his 
novel, The Custodian of Paradise
When:  Friday, November 3, 7 p.m.
Where:  Chapters Indigo Bookstore, 2376 Princess 
Street, Kingston, ON
Cost:  Free
Contact:  khenderson@randomhouse.com 

BOOK PUBLISHERS’ PROFESSIONAL ASSOCIATION
www.bppa.ca
Just Say “No” to Sepia: Annual Covers Panel
When:  Tuesday, November 21, 6:30-8:30 p.m.
Where:  The Arts and Letters Club, 14 Elm Street
Cost:  $10 for members, $20 for non-members
Contact:  Andrea Battiston at info@bppa.ca to 
pre-register  

CANADIAN AUTHORS’ ASSOCIATION —TORONTO 
BRANCH
www.canauthorstoronto.org
Book Launch: Stumbling Through Darkness, a col-
lection of poetry and prose from CAA Toronto Branch 
members
When:  Thursday, November 16, 7 p.m.  
Where:  Northern District Library, 40 Orchard View 
Boulevard (one block north
of Eglinton Avenue, west of Yonge Street), Room 200

compiled by Anne Koenig

www.artbar.org
www.yorku.ca/akevents
www.bookfestwindsor.ca
www.rabble.ca/lounge
www.bppa.ca
www.canauthorstoronto.org
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Cost:  Free for members
Contact:  Ben Antao, president, at 
ben.antao@rogers.com or phone 416 250-8885

Crafting the Short Story: Workshop with Sharon 
Crawford
When:  Saturday, November 25, 10 a.m.-4 p.m.
Where:  Northern District Library, 40 Orchard View 
Boulevard (one block north of Eglinton Avenue, west of 
Yonge Street), Room 200
Cost:  Free for CAA members, $30 for non-members
Contact:  Jake Hogeterp, at hogie10@rogers.com 
to register

CANADIAN BOOKBINDERS AND BOOK ARTISTS GUILD 
(CBBAG)
www.cbbag.ca
Care of Collections (Course)
When:  Friday, November 3 to Sunday, November 5, 
10 a.m.-6 p.m. all three days
Where:  24 Castle Frank Crescent
Cost:  $210 for members, $270 for non-members 
which includes a one-year membership to CBBAG, pay-
able for the fi rst workshop only.  There is also a $25 
materials fee.   
Contact:  workshop@cbbag.ca or phone 416 581-1071. 
Register online, or download application form and send 
to address on Web site.  Phone registrations are not 
accepted.

It’s Friday Night and I Haven’t Got a Date
(Evening course teaching buttonhole book con-
struction)
When:  Friday, November 17, 6-9 p.m.
Where:  CBBAG Bindery, 60 Atlantic Avenue, Suite 112 
(near King and Dufferin Streets)
Cost:  $35, with a $10 materials fee
Contact:  workshop@cbbag.ca or phone 416 581-1071.  
Register online, or download application form and send 
to address on Web site.  Phone registrations are not 
accepted.

Secret Belgian Binding
When:  Saturday, November 18, 10 a.m.-5 p.m.
Where:  CBBAG Bindery, 60 Atlantic Avenue, Suite 112 
(near King and Dufferin Streets)
Cost:  $70 for members, $95 for non-members
Contact:  workshop@cbbag.ca or phone 416 581-1071.  
Register online, or download application form and send 
to address on Web site.  Phone registrations are not 
accepted.
 

CANADIAN CHILDREN’S BOOK CENTRE
www.bookcentre.ca
Toronto Children’s Literature Roundtable 
(discussion): O.R. Melling: A Conversation
When:  Monday, November 20, 7:30-9:30 p.m.
Where:  Canadian Children’s Book Centre, 40 Orchard 
View Boulevard, Suite 101
Cost:  $7 per session or $25 for all four sessions. For 
students or seniors, it is $4 per session or $15 for all 
four sessions.
Contact:  Dian Borek at 416 394-1040 or 
dborek@torontopubliclibrary.ca   

CANADIAN FEDERATION OF POETS (CFP)
www.federationofpoets.com
Burlington Federation BAC (Burlington Art Cen-
tre) Event
When:  Sunday, November 19, 2-4 p.m.
Where:  Burlington Art Centre, 1333 Lakeshore Road, 
Burlington, ON
Cost:  Free; anyone is welcome to attend 
www.federationofpoets.com/burlington.htm
Contact:  or 905 632-7796 (Burlington Art Centre)

The Oakville Arts Council’s Poetry Café
When:  Sunday, November 19, 2-4 p.m.
Where:  Moonshine Café, 137 Kerr Street, Oakville, ON
Cost:  $5
Contact:  Elka Ruth Enola at 905 257-7075 or 
ere@sympatico.ca 
    

www.cbbag.ca
www.bookcentre.ca
www.federationofpoets.com
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CANADIAN INFORMATION PROCESSING SOCIETY 
(CIPS)
www.cipstoronto.ca 
Dinner Meeting: Ready, Set, Go Agile: A step-by-step 
guide for managers and executives
When:  Thursday, November 9, 5:30 p.m.  
Where:  The Ontario Club, 5th Floor, Commerce Court 
South, 30 Wellington Street West (northeast corner of 
Wellington and Bay Streets)  
Cost:  $39 for members 2 days before or more, $44 for 
members at the door, $55 for guests  
Contact:  Register online only.  For enquiries, e-mail 
jeffk@cips.ca

CANADIAN SOCIETY OF CHILDREN’S AUTHORS, ILLUS-
TRATORS AND PERFORMERS (CANSCAIP)
www.canscaip.org 
Monthly Meeting
When:  November 8, 7:30 p.m.  
Where:  St. Bonaventure’s Parish Centre, 1300 Leslie 
Street, next to the Toronto Botanical Garden at the 
corner of Leslie Street and Lawrence Avenue East
Contact:  416 515-1559 or offi ce@canscaip.org

THE CENTRE FOR REFORMATION & RENAISSANCE 
STUDIES (UNIVERSITY OF TORONTO) (CRRS)
www.crrs.ca 
“Unlearned Lutherans: A Paris Doctor’s Defense of 
Universities against Luther, 1532” 
When:  Friday, November 10, 3:30-5 p.m.  
Where:  Northrop Frye Hall, University of Toronto, 73 
Queen’s Park Crescent East, Room 205
Cost:  Free  
Contact:  416 585-4468 for further information 
 
“The Language of Friendship and Conversation: 
Conversational Strategies and Female Alliance in 
the writing of Lady Jane Cavendish and Elizabeth 
Brackley”
When:  Friday, November 24, 3:30-5 p.m.
Where:  Northrop Frye Hall, University of Toronto, 73 
Queen’s Park Crescent East, Room 205
Cost:  Free
Contact:  416 585-4468 for further information

“Girls’ Own Shakespeare”
When:  Thursday, November 30, 4:15 p.m. (tea and 
coffee at 4 p.m.)
Where:  Burwash Hall, University of Toronto, 89 
Charles Street West, Senior Common Room
Cost:  Free
Contact:  crrs.vic@utoronto.ca for further information
  
East End Writers’ Group
www.samcraw.com 
Monthly Writing Critiques
(with guest speakers periodically)
When:  Wednesday, November 29, 7-10 p.m.  
Where:  1 Gardens Crescent (O’Connor Drive and St. 
Clair Avenue East) 
Cost:  Free
Contact:  Sharon Crawford at angel@samcraw.com or 
see Web site

EDITORS’ ASSOCIATION OF CANADA
www.editors.ca 
Substantive Editing: Advanced Seminar
When:  Saturday, November 4, 10 a.m.-4 p.m. 
(lunch will be provided)
Where:  Northrop Frye Hall, University of Toronto, 73 
Queen’s Park Crescent East, Room 119
Cost:  $105 for members, $119 for non-members
Contact:  416 975-5528 or toronto@editors.ca for 
more information.  Can register online.

Conquering Corporate Markets Seminar
When:  Saturday, November 11, 9:30 a.m.-5 p.m. 
(lunch will be provided)
Where:  Northrop Frye Hall, University of Toronto, 73 
Queen’s Park Crescent East, Room 119
Cost:  $130 for members, $170 for non-members
Contact:  416 975-5528 or toronto@editors.ca for 
more information.  Can register online.

On-Screen Editing Seminar
When:  Saturday, November 18, 9:30-5 p.m. (lunch 
will be provided)
Where:  Northrop Frye Hall, University of Toronto, 73 
Queen’s Park Crescent East, Room 119

Networking directory
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Cost:  $130 for members, $170 for non-members
Contact:  416 975-5528 or toronto@editors.ca for 
more information.  Can register online
    
Proofreading Seminar
When:  Saturday, November 25, 10 a.m.-5 p.m. (lunch 
will be provided)
Where:  Northrop Frye Hall, University of Toronto, 73 
Queen’s Park Crescent East, Room 119
Cost:  $125 for members, $165 for non-members
Contact:  416 975-5528 or toronto@editors.ca for 
more information.  Can register online

Graphic Design Basics for Editors Seminar
When:  Sunday, November 26, 1-4:30 p.m.
Where:  Northrop Frye Hall, University of Toronto, 73 
Queen’s Park Crescent East, Room 119
Cost:  $65 for members, $85 for non-members
Contact:  416 975-5528 or toronto@editors.ca for 
more information.  Can register online

Eight-Step Editing
When:  Tuesday, November 28, 10:15 a.m.-5:30 p.m. 
(lunch will be provided)
Where:  Lillian H. Smith Branch Library, 239 College 
Street, Room BC (one block east of Spadina Avenue 
and a ten-minute walk west of the Queen’s Park sub-
way station)
Cost:  $125 for members, $165 for non-members
Contact:  416 975-5528 or toronto@editors.ca for 
more information.  Can register online.

GREY BORDERS READING SERIES
www.greyborders.com 
Author Readings:  Terry Carroll and Mobashar Qureshi
When:  Tuesday, November 14, 7:30 p.m.
Where:  The Merchant Ale House, 98 St. Paul Street, 
St. Catharines
Cost:  Free
Contact:  editors@greyborders.com 

Author Readings:  Carol Malyon and Greg Betts
When:  Tuesday, November 21, 7:30 p.m.
Where:  The Merchant Ale House, 98 St. Paul Street, 

St. Catharines
Cost:  Free
Contact:  editors@greyborders.com 

GRITLIT: HAMILTON WRITERS’ FESTIVAL
www.gritlit.ca 
When:  Thursday, November 2 to Sunday, November 5
Where:  The Art Gallery of Hamilton, 123 King Street 
West, Hamilton, ON  
Cost:  $15 for an all-event pass, $5 for a single event.  
Tickets are available at Bryan Prince, Bookseller, 1060 
King Street West, Hamilton, 1 800 867-0090.
Contact:  Rachel Preston, chair, at 905 972-0369 or 
rachelpreston@sympatico.ca

HUMBER SCHOOL OF CREATIVE AND PERFORMING 
ARTS
www.creativeandperformingarts.humber.ca  
Humber Writers’ Circle Presents: Author Russell 
Smith and Assessor Sarah Heller, Literary Agent, The 
Helen Heller Agency
When:  Saturday, November 11, 10 a.m.-noon
Where:  Lakeshore Campus East, Humber College, 
3199 Lake Shore Boulevard West, Building “J” (south of 
the Gardiner Expressway, just east of Colonel Samuel 
Smith Park Drive) 
Cost:  $30  
Contact:  Hilary Higgins at 416 675-6622, ext. 3449, 
or hilary.higgins@humber.ca 

INTERNATIONAL ASSOCIATION OF BUSINESS COMMUNI-
CATORS —TORONTO CHAPTER (IABC)
toronto.iabc.com
Make Your Move in Mississauga! IABC Westend 
Munch ‘n’ Mingle (Wear or bring your dancing 
shoes; a salsa instructor will be there.)
When:  Wednesday, November 8, 6-9 p.m.
Where:  On The Curve Hot Stove & Wine Bar, private 
party room, 55 City Centre Drive (at Square One)  
Cost:  $35 for members, $40 for non-members  
Contact:  Register online

Networking directory
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MAGAZINESCANADA.CA
www.cmpa.ca 
Magazines Canada School for Advertising Sales
When:  Friday, November 3 to Tuesday, November 7
Where:  The Pillar and Post Inn, Spa and Conference 
Centre, 48 John Street West, Niagara-on-the-Lake, ON 
Cost:  $2,500 for members, $3,700 for non-members
Contact:  Edra Sefton at 416 504-0274, ext. 224 or 
courses@magazinescanada.ca. Register online

ONTARIO LIBRARY ASSOCIATION (OLA)
www.accessola.com
The Holistic Librarian: Thriving in Your Work and 
Life Conference
When:  Thursday, November 9, 9:30 a.m.-4:30 p.m.
Where:  89 Chestnut Residence, 89 Chestnut Street 
(two blocks east of University Avenue, just south of 
Dundas Street)  
Cost:  $149 + GST for members, $199 + GST for non-
members  
Contact:  Register online by November 2

PAGES BOOKS & MAGAZINES
www.pagesbooks.ca 
Ben Schott’s Trivia Challenge
When:  Monday, November 6, 7:30-10 p.m. 
Where:  Gladstone Hotel Ballroom, 
1214 Queen Street West
Cost:  Free
Contact:  above Web site

Author Event:  Kagan McLeod and Mireille Silcoff in 
conversation with Hal Niedzviecki
When:  Tuesday, November 7, 7:30-10 p.m.
Where:  Gladstone Hotel Ballroom, 
1214 Queen Street West
Cost:  Free
Contact:  above Web site

Author Event:  Simon Houpt talks about his book, 
Museum of the Missing: A History of Art Theft
When:  Wednesday, November 15, 7:30-10 p.m.
Where:  Gladstone Hotel, Second Floor Gallery, 1214 
Queen Street West
Cost:  Free
Contact:  above Web site

From the Mercury Lab: Jay MillAr’s Molecular Fic-
tion and Sharon Harris’ Poetic ‘Pataphysics 
When:  Monday, November 20, 7:30-10 p.m.
Where:  Gladstone Hotel Ballroom, 
1214 Queen Street West
Cost:  Free
Contact:  above Web site

Author Event:  Thomas Homer-Dixon talks about his 
book, The Upside of Down
When:  Thursday, November 23, 7:30-10 p.m.
Where:  Innis Town Hall, 2 Sussex Avenue
Cost:  $5. Tickets will be available at Pages Books & 
Magazines.
Contact:  above Web site

From the Editors of Coach House Books:  The State 
of the Arts: Culture in Toronto 
When:  Sunday, November 26, 2:30-10 p.m. 
Where:  Gladstone Hotel Ballroom, 
1214 Queen Street West
Cost:  $5 (free entrance with book purchase at the 
event)
Contact:  View above Web site 

PROFESSIONAL LEARNING CENTRE, FACULTY OF 
INFORMATION STUDIES, UNIVERSITY OF TORONTO
www.plc.fi s.utoronto.ca 
Course: Infl uencing Decision Making, Strategies 
for Getting Results You Want 
When:  Tuesday, November 7 to Wednesday, November 
8, 9 a.m.-4 p.m. both days
Where:  Faculty of Information Studies, University 
of Toronto, 140 St. George Street (north of Spadina 
Avenue)
Cost:  $425
Contact:  Register online
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Advanced Web Search Strategies Workshop
When:  Friday, November 17, 9 a.m.-4 p.m.
Where:  Faculty of Information Studies, University 
of Toronto, 140 St. George Street (north of Spadina 
Avenue)
Cost:  $245
Contact:  Register online

Introduction to Managing Electronic Records 
Course
When:  Tuesday, November 21, 9 a.m.-4 p.m.
Where:  Faculty of Information Studies, University 
of Toronto, 140 St. George Street (north of Spadina 
Avenue)
Cost:  $210
Contact:  Register online

Copyright: Understanding and Applying the Rules 
Course
When:  Thursday, November 30, 9 a.m.-4 p.m.
Where:  The Business Inn, 180 MacLaren Street (at 
Elgin), Ottawa
Cost:  $260
Contact:  Register online    

PROFESSIONAL WRITERS ASSOCIATION OF CANADA 
—TORONTO CHAPTER
www.pwactoronto.org
The Art of the Query Letter: How to Develop 
Article Ideas and Sell Them to Newspapers and 
Magazines Workshop
When:  Saturday, November 4, 10 a.m.-3:45 p.m.
Where:  Copernicus Lodge, 66 Roncesvalles Avenue  
Cost:  $95 for members (which includes EAC mem-
bers), $125 for non-members. (Fees go up $15 two 
weeks before the start date.)
Contact:  www.paullima.com/workshops for more 
information.  Register at Paul Lima’s Web site or 
through PWAC’s Web site.

Copywriting 101 Workshop
When:  Saturday, November 18, 10 a.m.-3:45 p.m.
Where:  Copernicus Lodge, 66 Roncesvalles Avenue
Cost:  $95 for members (which includes EAC mem-
bers), $125 for non-members.  (Fees go up $15 two 
weeks before the start date.)

Contact:  www.paullima.com/workshops for more 
information.  Register at Paul Lima’s Web site or 
through PWAC’s Web site.

Body, Mind, and Soul: Wellness for Writers Semi-
nar
When:  Wednesday, November 29, 7-8:30 p.m.  
Where:  Northern District Library, 40 Orchard View 
Boulevard (one block north of Eglinton Avenue, west of 
Yonge Street)
Cost:  Free for PWAC members, pay what you can for 
guests ($10 suggested)

RANDOM HOUSE OF CANADA LTD.
www.randomhouse.ca
Author Event: Bill Bryson, author of The Life and 
Times of the Thunderbolt Kid
When:  November 2, 7 p.m.
Where:  St. Barnabas Church, 361 Danforth Avenue 
(between Broadview and Pape Avenues)
Cost:  Free  
Contact: above Web site

Royal Ontario Museum (ROM)
www.rom.on.ca
Author Event:  Jeffrey Crelinsten will speak about his 
book, Einstein’s Jury: The Race to Test Relativity
When:  Sunday, November 19, 1:30-2:30 p.m.  
Where:  Royal Ontario Museum, 100 Queen’s Park 
Crescent
Cost:  $13 for members, $16 for non-members  
Contact:  416 586-5797, ext. 2 or e-mail programs@
rom.on.ca. Can register online

Jose Latour: Reading and Reminiscences
When:  Thursday, November 23, 7-9 p.m.
Where:  Royal Ontario Museum, Level 4, RBC Founda-
tion Glass Room
Cost:  Free (does not include ROM admission)
Contact:  416 586-5524 or e-mail icc@rom.on.ca for 
more information.  Registration is not required  
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SALON DU LIVRE DE MONTRÉAL [THE LARGEST FRAN-
COPHONE LITERARY FESTIVAL IN NORTH AMERICA]
www.salondulivredemontreal.com 
When:  Thursday, November 16 to Monday, November 
20
Where:  Place Bonaventure Exhibition Hall, Level 400, 
800 De La Gauchetière Street West, Montreal, QC  
Cost:  Daily: $6 for adults, $4 for full-time students; 
$10 passport for all fi ve days.  Tickets may be pur-
chased via the Web site on October 16.  
Contact:  slm.info@videotron.ca or 514 845-2365

Society for Technical Communication (STC)
www.stctoronto.org
Information Design: A Structured Approach to 
Planning Content [A Saul Carliner Workshop]
When:  Monday, November 6, 9 a.m.-4:30 p.m.
Where:  Holiday Inn Toronto Yorkdale, 3450 Dufferin 
Street (on the west side of Dufferin Street, south of 
Highway 401)
Cost:  $180 for members, $260 for non-members
Contact:  Jennifer Paton Smith at 
education@stctoronto.org to register

Monthly Meetings
When:  Second Tuesday of each month, November 14, 
7 p.m.
Where:  Gold Room, North York Memorial Community 
Hall, Toronto Public Library, 5110 Yonge Street
Cost:  Free for members, $5 for non-members (fi rst 
time free)
Contact:  Rob Hanna at president@stctoronto.org or 
416 221-4113

STORY SEMINAR WITH ROBERT MCKEE
When:  Friday, November 17 to Sunday, November 19, 
9 a.m.-8:30 p.m. all three days (Doors open at 8 a.m. 
on Friday for registration.)
Where:  Northrop Frye Hall, 73 Queen’s Park Crescent 
East, Room NF003 
Cost:  $595 + GST (Tax receipt will be provided) 
Repeater Rate: $350 + GST Contact:  Robert McKee’s 
Web site at www.mckeestory.com for more information 
or phone 1 888-602-9361. Register online at 
www.whitedogseminars.com 

TO LIVE WITH CULTURE 05/06
www.livewithculture.ca  
Book Launch:  Anand Mahadevan launches his new 
novel, The Strike
When:  Sunday, November 5, 2-4 p.m. 
Where:  David Mirvish Books on Art, 596 Markham 
Street (two blocks west of Bathurst Street, south of 
Bloor Street)
Cost:  Free
Contact:  www.tsarbooks.com for more information

Book Launch:  The Toronto Renaissance Conspiracy 
launches their second poetry anthology, Renaissance 
Reloaded, with readings, a book signing, and musical 
guest Arthur Renwick
When:  Wednesday, November 8, 7:30 p.m.
Where:  Renaissance Café, 1938 Danforth Avenue (two 
blocks west of Woodbine Avenue)
Cost:  Free
Contact:  416 422-1441 or toronto.renaissance.con-
spiracy@rogers.com

TORONTO CENTRE FOR THE BOOK (UNIVERSITY OF 
TORONTO)
www.library.utoronto.ca/tcb 
Lecture:  Marc-André Bernier will speak about The Bib-
liotheca Rhetorum of the First Canadian Literati 
When:  Thursday, November 16, 4:15 p.m.  
Where:  Teefy Hall, St. Michael’s College, University of 
Toronto, 57 Queen’s Park Crescent East, Room 102
Cost:  Free
Contact:  See above Web site

TORONTO PUBLIC LIBRARY
www.torontopubliclibrary.ca
Author Series: Stories from the Past Ami McKay 
reads from her novel, The Birth House and Steven 
Heighton reads from his novel, Afterlands. A question 
and answer period will follow the readings.
When:  Thursday, November 2, 7 p.m.  
Where:  Toronto Reference Library, Elizabeth Bee-
ton Auditorium, 789 Yonge Street (on the east side of 
Yonge Street, one block north of Bloor Street)  
Cost:  Free  
Contact:  See above Web site
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Writing Away from Home Workshop:  This 
workshop will be conducted by writer-in-residence Rab-
indranath (Robin) Maharaj
When:  Saturday, November 4, 2-4 p.m.
Where:  Toronto Reference Library, Asquith Room, 789 
Yonge Street (on the east side of Yonge Street, one 
block north of Bloor Street)
Cost:  Free
Contact:  See above Web site

Zines, Indie Magazines, and a Free Press: Touring 
the Periodicals with Hal Niedzviecki 
When:  Saturday, November 11, 2-4 p.m.
Where:  Toronto Reference Library, Elizabeth Bee-
ton Auditorium, 789 Yonge Street (on the east side of 
Yonge Street, one block north of Bloor Street)
Cost:  Free
Contact:  See above Web site

Author Series: Urban Issues John Lorinc reads from 
his book, New City: How the Crisis of Canadian Cities 
is Reshaping Our Nation and Joe Fiorito reads from his 
book, Union Station: Love, Madness, Sex and Survival 
on the Streets of the New Toronto. A question and 
answer period will follow the readings.    
When:  Thursday, November 16, 7 p.m.
Where:  Toronto Reference Library, Elizabeth Bee-
ton Auditorium, 789 Yonge Street (on the east side of 
Yonge Street, one block north of Bloor Street)
Cost:  Free
Contact:  above Web site for further information

Short Story Workshop:  This workshop will be con-
ducted by writer-in-residence Rabindranath (Robin) 
Maharaj
When:  Wednesday, November 22, 1-4 p.m.
Where:  Toronto Reference Library, Asquith Room, 789 
Yonge Street (on the east side of Yonge Street, one 
block north of Bloor Street)
Cost:  Free
Contact:  See above Web site 
  
Book Club:  Small Island by Andrea Levy will be dis-
cussed
When:  Tuesday, November 28, 7-8:30 p.m.
Where:  North York Central Library, 5120 Yonge Street, 

Room 2 (on the west side of Yonge Street, north of 
Sheppard Avenue)
Cost:  Free; however, you must register
Contact:  Browsery Desk at 416 395-5672 to register

Author Series: War Stories Heather Pringle reads 
from her book, The Master Plan: Himmler’s Scholars 
and the Holocaust and Michael Crummey reads from his 
book, The Wreckage. A question and answer period will 
follow the readings.
When:  Thursday, November 30, 7 p.m.
Where:  Toronto Reference Library, Elizabeth Bee-
ton Auditorium, 789 Yonge Street (on the east side of 
Yonge Street, one block north of Bloor Street)
Cost:  Free
Contact:  See above Web site

TORONTO WRITERS’ CENTRE
www.writerscentre.ca 
eBooks: How to Write, Sell, and Promote Work-
shop
When:  Saturday, November 4, 10 a.m.-noon
Where:  Toronto Writers’ Centre, 101 Yorkville Ave-
nue, Suite 200 (two blocks north of Bloor Street West, 
between Avenue Road and Bay Street)
Cost:  $25 for members, $35 for non-members
Contact:  416 975-5172 or md@writerscentre.ca f
or tickets

The Insider Introduction to Getting Published 
Workshop
When:   Thursday, November 16 to Friday, November 
17, 9:30 a.m.-4 p.m.
Where:  Toronto Writers’ Centre, 101 Yorkville Ave-
nue, Suite 200 (two blocks north of Bloor Street West, 
between Avenue Road and Bay Street)
Cost:  $329
Contact:  Cynthia Good at 416 675-6622, ext. 3462 or 
cynthia.good@humber.ca for more information. Contact 
Hilary Higgins at 416 675-6622, ext. 3449 or 
hilary.higgins@humber.ca to register
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Travel and Writing: What’s Not to Like?
When:  Tuesday, November 21, 7 p.m.
Where:  Toronto Writers’ Centre, 101 Yorkville Ave-
nue, Suite 200 (two blocks north of Bloor Street West, 
between Avenue Road and Bay Street)
Cost:  Free for members, $10 for non-members
Contact:  416 975-5172 or md@writerscentre.ca 
for tickets  

TORONTO ROMANCE WRITERS
www.torontoromancewriters.com
Tax Tips for Writers 
When:  Saturday, November 11, 1-4 p.m.  
Where:  North York Central Library, 5120 Yonge Street 
(on the west side of Yonge Street, just north of Shep-
pard Avenue)
Cost:  Free
Contact:  torontoromancewriters@yahoo.com 

TORONTO WOMEN’S BOOKSTORE (TWB)
www.womensbookstore.com
Women in Action Program—Speaking/Writing in 
Narrative 
When:  Four consecutive Mondays: November 13, 20, 
27, and December 4, 6-9:30 p.m. all days
Where:  Centre for Women’s Studies in Education, 
OISE, University of Toronto, 252 Bloor Street West, 
Room 2-227 (one block west of St. George Street)
Cost:  $125; please register in advance
Contact:  www.oise.utoronto.ca/cwse/events.html for 
more information. Contact Pam Patterson at 416 923-
6641, ext. 2204 or ppatterson@oise.utoronto.ca

Written in Colour —A Symposium for Emerging 
and Experienced Writers and Storytellers of Col-
our and Indigenous Authors
When:  Friday, November 17 to Sunday, November 19
Where:  To Be Announced
Cost:  To Be Announced
Contact:  See above Web site

Indigenous Women and Feminism Lecture
When:  Tuesday, November 21, 7 p.m. (Reception to 
follow at Massey College)
Where:  George Ignatieff Theatre, 15 Devonshire Place 
(east of St. George Street, south of Bloor Street)
Cost:  Free
Contact:  Pat Doherty at 416 923-6641, ext. 2204 or 
pdoherty@oise.utoronto.ca for more information or see 
above Web site
  

THE UNIVERSITY OF TORONTO BOOKSTORE
www.uoftbookstore.com/online
Reading Series: Author Jack Whyte discusses his 
novel, Knights of the Black and White with Interviewer 
Mark Askwith
When:  Monday, November 6, 7:30 p.m. 
Where:  Hart House, University of Toronto, Library, 7 
Hart House Circle
Cost: Free
Contact:  416 640-5836 or events@uoftbookstore.com 
or view above Web site for more information

Heat: How to Stop the Planet from Burning Linda 
McQuaig interviews George Monbiot, author of Heat: 
How to Stop the Planet from Burning
When:  Monday, November 13, 7:30 p.m.
Where:  Hart House, University of Toronto, Library, 7 
Hart House Circle
Cost:  Free
Contact:  416 640-5836 or events@uoftbookstore.com 
or view above Web site for more information

Pandemonium is Here: Are We Ready? Authors 
Andrew Nikiforuk, Dr. Vincent Lam and Dr. Colin Lee will 
discuss viruses that are plaguing civilization and will 
offer a survival guide
When:  Tuesday, November 14, 7:30 p.m.
Where:  Hart House, University of Toronto, Library, 7 
Hart House Circle
Cost:  Free
Contact:  416 640-5836 or events@uoftbookstore.com 
or view above Web site for more information
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WORLD LITERACY OF CANADA
www.worldlit.ca
Eyes on India 2006: A Tribute to the 100th Anniversary of R.K. Narayan
When:  Tuesday, November 7, 6 p.m. 
Where:  The 6 p.m. reception is at McKinsey & Company, 110 Charles Street West 
(south of Bloor Street, west of Bay Street); the 7 p.m. tribute and fi lm screening is 
at The Isabel Bader Theatre, 93 Charles Street West
Cost: $75, which includes a charitable tax receipt for $50
Contact:  416 977-0008 to reserve tickets

THE WRITERS & EDITORS NETWORK (WEN)
www.wenetwork.org
Breakfast Meeting: Sue Kenney, author of Sue Kenney’s My Camino
When:  Saturday, November 18, 9-11:30 a.m.
Where:  Canadiana Restaurant, Six Points Plaza, 5230 Dundas Street West,
Mississauga
Cost:  $13 for WEN members, $16 for non-members
Contact:  Register online, at least 6 working days before the date

THE WRITERS’ CIRCLE OF DURHAM REGION (WCDR)
www.wcdr.org
Port Perry Weekly Freefall Workshop (Six weeks of writing with weekly seminars)
When:  Wednesday evenings from November 15 to December 20, 7-9:30 p.m. all days  
Where:  369 Rosa Street, Port Perry, ON (a one-hour drive from Toronto)
Cost:  $315 less a $20 discount for WCDR members
Contact:  www.freefallwriting.com/international%20dates.html to register

THE WRITERS’ TRUST OF CANADA
www.writerstrust.com
The Writers’ Trust Great Literary Dinner & 30th Anniversary Celebration
When:  Wednesday, November 15, time to be announced
Where:  The Four Seasons Hotel, 21 Avenue Road (north of Bloor Street, south of Yorkville Avenue)
Cost:  To be announced 
Contact:  Don Oravec, Executive Director, 416 504-8222, ext. 244 or doravec@writerstrust.com  �  
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Bon mots

Remember the waterfront shack with the sign 
FRESH FISH SOLD HERE. Of course it’s fresh, we’re 
on the ocean. Of course it’s for sale, we’re not giving 
it away. Of course it’s here, otherwise the sign would 
be someplace else. The fi nal sign: FISH. 
— Peggy Noonan  (1950– ) American writer
                                                                                    

❝

❞

The lighter side of life

The Bittersweet Robbery

Some time ago, a British woman discovered that her debit card had 
been stolen. She immediately went on the Internet to check her 
balance and saw that her account had $500 more in it than it had 

before.  Apparently the thief had used her card to bet 
on the horses and won, and his winnings 
were paid directly into her account. Th e 

thief was eventually arrested, con-
victed, and placed on proba-

tion. But as the $500 was won 
fairly and squarely, she was 
permitted to keep this money 
and so lived happily ever after.




